
Chapter 2

Getting Started with 
AutoCAD MEP

 Learning Objectives  
After completing this chapter, you will be able to:
•	 Understand the workflow path
•	 Use the Project Browser
•	 Understand the concept of space
•	 Specify the space object settings		
•	 Work with space styles and tools		
•	 Understand the concept of zones		
•	 Switch Workspaces in MEP	
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INTRODUCTION			    
AutoCAD MEP, a software based on AutoCAD platform, is used to design, draft, and document 
electrical, mechanical, and piping system of buildings. The first step while creating such a 
system is to create a project. Thereafter drawings are added to this project to represent various 
components of the building like electrical system, ducts, and so on. These drawings are then 
arranged according to the workflow of the project.  

WORKFLOW
Workflow is a sequence of connected steps required to create a specific type of system. It is 
dependent on the system to be created. For example, for an HVAC system, the workflow is shown 
in Figure 2-1. The steps involved in this workflow are discussed next.

Figure 2-1  Workflow for an HVAC system in AutoCAD MEP

Specifying the HVAC Parameters
In this step, you need to specify all the parameters required to create an HVAC system. Some of 
the parameters are duct size, duct rise and drop, flow rate, cut length, and so on. On the basis 
of these parameters, the hierarchy of drawings in project will be decided.
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Starting a Project
In this step, you need to create a project file to link the drawings of a system to each other. For 
example, the drawings related to HVAC system will be interlinked and will be in the same project. 
As a result, you can easily manipulate the parameters of the system.

Linking System File to the Architectural Plan
To create an HVAC system, you need to have an architectural plan. In this step, you will link 
the HVAC system file to the architectural plan file using the PROJECT NAVIGATOR. After 
the completion of this step, you can reroute the HVAC lines according to the architectural plan.

Specifying Spaces and Zones
In this step, you need to create spaces and zones using the tools available in AutoCAD MEP. These 
spaces are used for exporting the building information related to the heating and cooling loads. 
The spaces are further divided into zones which represent the actual heating and cooling loads.

Calculating Loads
In this step, you need to calculate the heating and cooling loads for the building. These 
calculations are performed by using the analysis tools available in AutoCAD MEP. 

Note
In this textbook, the global unit system is followed, therefore you need to start AutoCAD MEP 2022 
by double-clicking on the AutoCAD MEP 2022 - English (Global) icon available on the desktop.

PROJECT BROWSER
The Project Browser is used to manage project files. A project file contains the record of  drawing 
files related to a category. For example, a building project file may have a record of drawing files 
related to piping, electrical, and different types of floors. You can create a new project file by 
using the options available in the Project Browser. Also, you can configure an existing project 
file. The Project Browser can be invoked by entering the PROJECTBROWSER command at 
the command prompt or by using the Application Menu. To invoke it from the Application 
Menu, hover the cursor on the Open option in the menu; a flyout will be displayed. Choose the 
Project button from the flyout; the Project Browser will be displayed, as shown in Figure 2-2.

In the Project Browser, the list of projects available in the selected directory is displayed in 
the left pane of the Project Browser. To change the current directory, click on My Projects 
from the left area of the dialog box; a drop-down list will be displayed having shortcuts to some 
common directories such as Documents and Desktop. Using these shortcuts, browse to the 
desired directory and select the category as the current directory; all the projects available in 
the selected directory will be displayed in the left pane of the Project Browser. In addition to 
the existing projects, you can also create a new project file by using the options available in the 
Project Browser. The procedure to create a new project file is discussed next.

Creating a New Project File
A new project file can be created by using the New Project tool available at the bottom left corner 
of the Project Browser. On choosing this tool, the Add Project dialog box will be displayed, as 
shown in Figure 2-3.
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Figure 2-2  The Project Browser

Figure 2-3  The Add Project dialog box

There are three edit boxes available in this dialog box namely: Project Number, Project Name, 
and Project Description. The Project Number edit box is used to specify a unique number for 
the project file. The Project Name edit box is used to specify the name for the project file. The 
Project Description edit box is used to specify the description about the project file. You can 
use any of standard templates for the project. To do so, select the Create from template project 
check box from the Add Project dialog box if not already selected; the edit box below the check 
box will be activated. Next, choose the Browse button available next to the edit box activated; 
the Select Project dialog box will be displayed, as shown in Figure 2-4.
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Figure 2-4  The Select Project dialog box

Browse to the location where template files are stored and then

Figure 2-5  The PROJECT 
NAVIGATOR

 
choose the Open button after selecting the desired template 
file. The selected template file will be used for the current 
project. Note that in this textbook, the standard template used 
is Commercial Template Project (Metric).apj. To select the template, 
browse to the location C:\ProgramData\Autodesk\MEP 2022\enu\
Template\Commercial Template Project (Metric) and then select the 
Commercial Template Project (Metric) template file. Next, choose 
the Open button; the path of the selected file will be added 
to the edit box displayed below the Create from template 
project check box. Specify the name of project in the Project 
Name edit box and choose the OK button from the Add 
Project dialog box; a project file with the specified name will 
be created and also a copy of drawing files in the template 
project will be created in the new project folder. The extension 
of the project file is .apt. Now, close the Project Browser by 
choosing the Close button. On closing the Project Browser, 
the PROJECT NAVIGATOR will be displayed, refer to 
Figure 2-5. 
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PROJECT NAVIGATOR		
The PROJECT NAVIGATOR is used to navigate the drawing files of a project. Using the 
PROJECT NAVIGATOR, you can edit or create building drawings and other documentation 
data. The PROJECT NAVIGATOR has four tabs: Project, Constructs, Views, and Sheets. 
These tabs are discussed next.

Project Tab
The Project tab has three areas. These areas display the information about project name, number 
of levels in the building, and divisions of building of the project. The tools available at the bottom 
of the PROJECT NAVIGATOR are used to configure the project. The areas and the options 
available in the Project tab are discussed next.

Current Project
The Current Project area is used to store the project file name, project file number, and 
description of the project.

Levels					   
The Levels area contains information of various levels used in the project file. In case of AutoCAD 
MEP, level refers to floor. In this area, level names are displayed in the Name column and their 
corresponding height values are displayed in the Elevation column.

Divisions Area
The Divisions area contains information of various divisions of the building. A division of the 
building refers to its different segments and each segment contains its own name.

Project Browser
The Project Browser tool is used to invoke the Project Browser dialog box. This dialog 
box has already been discussed.

Close Current Project
The Close Current Project tool is used to close the current project file as well as the 
PROJECT NAVIGATOR. The tool palette opened in the current project will also get closed.

Content Browser
The Content Browser tool is used to display the content browser library of catalogs that 
allows you to store, share and exchange the AutoCAD Architecture contents, tools, and tool 
palettes. When you invoke the Contents Browser tool, the Autodesk Content Browser 2022 

window is displayed. as shown in Figure 2-6. By default, the items provided by the Autodesk 
supplied tools catalogs will be displayed in the Autodesk Content Browser 2022 window. You 
can also create your own tools catalogs and can also copy other tool catalogs into your catalog 
library. The existing catalog library or website links also can be added into the Autodesk Content 
Browser 2022 window. To create new catalog or to add an existing library, choose the Click to 
add or create a catalog button available in the bottom left corner of the dialog box; the Add 
Catalog dialog box will be displayed. Using this dialog box you can add or create new catalogs. 
When you double-click on the any of the standard catalogs in the Autodesk Content Browser 
2022 window, different catagories related to that catalog will be displayed, refer to Figure 2-7.
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Figure 2-6  The Autodesk Content Browser 2022 window

Figure 2-7  The Autodesk Content Browser 2022 window displaying component categories

When you click on any of the categories shown in Figure 2-7, the palettes related to that category 
will be displayed in the Autodesk Content Browser  window, refer to Figure 2-8. When you click 
on any of the palettes shown in Figure 2-8; the components related to that palette will be displayed 
in the Autodesk Content Browser 2022 window, refer to Figure 2-9. You can import any of the 
components tool available in Autodesk Content Browser 2022 to the TOOL PALETTES. To 
do so, press and hold the left mouse button on the icon of the component and then drag it to 
the TOOL PALETTES. The component will be placed in the TOOL PALETTES.

Note
The Tool Palettes will be displayed only when you are in the Drawing environment.
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Figure 2-8  The Autodesk Content Browser 2022 window displaying component palettes

Figure 2-9  The Autodesk Content Browser 2022 window displaying component categories

Synchronize Projects
The Synchronize Projects tool is used to synchronize the current project with the AEC 
project standards. To synchronize the project, choose the Synchronize Projects tool available 

at the bottom of the PROJECT NAVIGATOR. On doing so, the Analyzing Project Drawings 
window will be displayed showing the progress of synchronization of drawing files. When all the 
drawing files are synchronized to the AEC Project standards, the Synchronize Project with 
Project Standards dialog box will be displayed, refer to Figure 2-10. The upper half of the dialog 
box shows the objects in the drawing file of the project that do not match with the AEC Project 
standards and can be updated from the standards. The lower half shows the files that are not 
present in the project standards and  can be skipped or ignored while synchronizing the project 
by selecting the appropriate option from the Action drop-down list. 

The drawing files available in the current project are displayed in the Host Drawing column of 
this dialog box. For every file, the status for the availability of the updated version is displayed 
in the Status column of the dialog box. You can synchronize the drawing files which show Newer 
Version in their Status column. To synchronize a drawing file, click on its corresponding field in 
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the Action column; a drop-down list will be displayed, refer to Figure 2-10. Select the Update 
from Standard option from the drop-down list; the selected file will be synchronized. Similarly, 
you can synchronize more than one file at a time by pressing and holding the CTRL key while 
selecting the files. 

Figure 2-10  The Synchronize Project with Project Standards dialog box

Configure Project Standards
The Configure Project Standards tool is used to set up the project standard. These project 
standards are used to synchronize the project drawings. When you choose this tool, the 

Configure AEC Project Standards dialog box will be displayed, refer to Figure 2-11. The 
Standard Styles tab is chosen by default in the dialog box. You can standardize any of the objects 
available in the Objects list of this tab by selecting the check box corresponding to the object 
in the dialog box. If you choose the Synchronization tab, three radio buttons will be displayed: 
Automatic, Semi-automatic, and Manual.

The Manual radio button is selected by default. As a result, project drawings will not be 
synchronized with the project standards automatically and you would need to synchronize 
them manually. If you select the Semi-automatic radio button, the project standards will be 
applied only when the project drawing is opened. Also, you will be prompted to apply project 
standard on each opened project drawing. If you select the Automatic radio button, the project 
standards will be applied on each opened drawing without any prompt. Using the options in 
the AutoCAD Standards tab, you can load any AutoCAD Standard file to apply it as a standard 
on the project drawings.



2-10			                	       AutoCAD MEP 2022 for Designers
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 2-11  The Configure AEC Project Standards dialog box

Constructs Tab
The options in the Constructs tab are used to modify

Figure 2-12  The PROJECT NAVIGATOR 
with the Constructs tab chosen

the drawing files available in the project. On 
choosing the Constructs tab, the PROJECT 
NAVIGATOR will be modified, as shown in 
Figure 2-12. Some of the options in this tab have 
already been discussed. The remaining options 
available in this tab are discussed next.

 
Constructs Area		
The Constructs area has all the drawings of the 
current project arranged in a tree structure. In 
the tree, the drawing files are divided into two 
main categories: Constructs and Elements, 
which are further categorized according to their 
purpose/function. For example, the architectural 
drawings are stored in the Architectural category. 
You can open any of the drawings available in these 
folders by double-clicking on it.

Add Category
The Add Category tool is used to add a new 
category in the PROJECT NAVIGATOR to 
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categorize the drawing files according to their usage. To do so, select a node from the Constructs 
rollout of the PROJECT NAVIGATOR and then choose the Add Category tool; the category 
will be added under the selected node.  

Add Construct
The Add Construct tool is used to add a new construction in the project. When you choose 
this tool, the Add Construct dialog box will be displayed, as shown in Figure 2-13. You 

can add description about the new construct, change the name, edit category, and change the 
template using the fields available in the dialog box. In this dialog box, check boxes corresponding 
to each level of floor in the building are available in the Assignments area. Select the check 
boxes corresponding to the levels to which you want to add the construction. If you select multiple 
check boxes in this dialog box, then the objects created in the construction will span between 
the levels selected. Therefore, it is recommended to select only one check box. You can open 
the newly created construct by using the Open in drawing editor check box. When you select 
this check box and choose the OK button, the Add Construct dialog box will close and the 
newly created construction will open in AutoCAD MEP for editing.

Figure 2-13  The Add Construct dialog box

Add Element
The Add Element tool is used to add a new element to the project. When you choose this 
tool, the Add Element dialog box will be displayed. Enter the required details in this 

dialog box and choose the OK button; a new element is added to the Elements category. You 
can edit the newly added element by selecting the Open in drawing editor check box.
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Show External References
The Show External References tool is used to display external references for any drawing 
in the current project. When you select a drawing in the PROJECT NAVIGATOR and 

choose this button, the External References dialog box will be displayed. In the Details area 
of this dialog box, the information about the selected drawing is displayed, refer to Figure 2-14.

Views Tab
The options in the Views tab are used to add, modify, or delete a general, a detail, or a section 
view in the project. On choosing this tab, the PROJECT NAVIGATOR will be modified, refer 
to Figure 2-15. Some of the options in this tab have already been discussed. The remaining 
options in this tab are discussed next.
         

Figure 2-14  The External References dialog 
box

Figure 2-15  The PROJECT NAVIGATOR with 
the Views tab chosen

Views Area
In this area, different views of the project drawings are displayed in a tree structure. These views 
are divided into different categories on the basis of their application areas. For example, all the 
drawings related to interior of the building are available in the Interiors category in the Views 
tree. You can open any of the drawing views by double-clicking on it.
 
Add View

There are three types of views that can be added to the View area: General view, 
Section/Elevation view, and Detail view. The Add View tool is used to add a new view to 
the View area. On choosing the Add View tool, the Add View dialog box will be displayed, 
as shown in Figure 2-16. 
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Figure 2-16  The Add View dialog box

There are three options available in this dialog box: Add a General View, Add a Section/Elevation 
View, and Add a Detail View. On choosing an option, the respective dialog box will be displayed. 
For example, when you choose the Add a General View option, the Add General View dialog 
box will be displayed, as shown in Figure 2-17.  

Figure 2-17  The Add General View dialog box

Using the options available in this dialog box, you can set the general properties of the view. 
Three pages are available in this dialog box: General, Context, and Content. The General page 
is displayed by default in this dialog box. In this page, you need to enter the general information 
about the view. After entering the general information, choose the Next button; the Context 
page will be displayed, refer to Figure 2-18.  
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Figure 2-18  The Add General View dialog box with the Context page displayed

On this page, you can select the portions of the building that you want to include in the current 
view. To do so, you can select the check boxes corresponding to the portions of the building 
required to be included in the current view. After selecting the check boxes, choose the Next 
button; the Content page will be displayed, refer to Figure 2-19.

Figure 2-19  The Add General View dialog box with the Content page displayed
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In this page, you can select the check boxes corresponding to those elements that you want to 
display in the current view. After specifying the required parameters, choose the Finish button to 
exit the dialog box. The newly created view will be displayed in the Views area of the PROJECT 
NAVIGATOR.

Regenerate View
The Regenerate View button is used to regenerate all the views so that you can get the 
updated version of the drawing views. This tool is also used to update the reference of the 
views.

Repath Xref
The Repath Xref tool is used to reconnect the external references whose names or locations 
have been changed.

Sheets Tab
On choosing this tab, the PROJECT NAVIGATOR 

Figure 2-20  The PROJECT NAVIGATOR 
with the Sheets tab chosen

will be modified, refer to Figure 2-20. The options 
in the Sheets tab are used to add, modify, or delete 
the sheets available in the project. Some of the 
options in this dialog box have already been 
discussed. The remaining options are discussed next.

Sheet Set View Area
All the drawing sheets available in the current project 
are displayed in the Sheet Set View area in a tree 
structure. You can open any of the drawing sheets 
by double-clicking on it.

Add Sheet
The Add Sheet tool is used to add a new sheet 
in the project. To do so, choose this tool; the 

New Sheet dialog box will be displayed, as shown in 
Figure 2-21. In this dialog box, you need to specify 
the sheet number, sheet title, and file name in their 
respective edit boxes. On specifying the sheet 
number and the sheet title in the edit boxes, a default 
file name is displayed in the File name edit box. You 
can change this file name or retain it. The folder 
path and the template path for the current sheet are displayed in the Folder path and Sheet 
template fields, respectively. These fields cannot be modified in this dialog box. After specifying 
the required parameters, choose the OK button from this dialog box; the newly created sheet 
will be added in the project and will be displayed at the bottom of the list in the PROJECT 
NAVIGATOR. You can edit this sheet by double-clicking on it. 
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Figure 2-21  The New Sheet dialog box

Publish
The Publish tool is used to publish the complete sheet set in DWF file format. To publish 
a sheet set, choose the Publish tool from the PROJECT NAVIGATOR; the AutoCAD 

MEP 2022 message box will be displayed, as shown in Figure 2-22. Choose the OK button from 
this message box; the Specify DWF File dialog box will be displayed, as shown in Figure 2-23. 
Choose the Select button from this dialog box; the Publish Job Progress message box will be 
displayed.

Figure 2-22  The AutoCAD MEP 2022 message box

This message box shows the progress of plotting/publishing of the drawing sheets. When the 
process of publishing completes, the Plot and Publish Job Complete message will be displayed 
at the bottom right corner and the plot file will be created at the location specified in the Specify 
DWF File dialog box. To view the details of the plot file, click on the Click to view plot and 
publish details link in the message box displayed at the bottom right corner of the application 
window; the Plot and Publish Details dialog box will be displayed with the details of the plot file.

STYLES BROWSER                                                  
The STYLES BROWSER palette is used to import the styles and system definition to current 
drawing. This palette is invoked automatically when you start a new project. You can also invoke 
it manually by choosing Home > Build > Tools drop-down > Styles Browser or by typing 
STYLESBROWSER in the command prompt. You can also override the style or definition of 
an existing object in the drawing area by using this palette.

The options/drop-downs available in the STYLES BROWSER palette, refer to Figure 2-24, are 
discussed next.
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Figure 2-23  The Specify DWF File dialog box

Figure 2-24  The STYLES BROWSER palette
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Object Type
Using the options in this drop-down, you can select different type of objects for which you 
can choose different styles or definitions. The objects types available in this drop-down are 
Architectural Objects, Documentation Objects, Multi-Purpose Objects, Electrical Objects, 
HVAC Objects, Piping Objects, Plumbing Objects, and Schematic Objects. You can select 
an object from it, apply the desired style from the gallery of  STYLES BROWSER palette and 
double-click on it to start the drawing with selected style. 

Drawing Source
You can select the drawing source for different object styles or definitions by using this drop-down 
list. Options available in this drop-down list are discussed next.

Content Library Drawings
When this option is selected, all available styles or definitions for the selected object will be 
displayed in the gallery.

Project Standard Drawings
When this option is selected, the project standard styles or definitions for the selected object 
will be displayed in the gallery.

Currently Open Drawings
When this option is selected, the styles or definitions that are available for the currently open 
drawings will be displayed.

Drawing File
The options available in this drop-down list filter the object styles or definitions for an object 
depending upon the option selected from the Drawing Source drop-down list. The options 
available in this drop-down list are All Drawings, Current Drawing, and All Without Current 
Drawing. For example, if you select the Current Drawing option, only the object styles for 
currently open drawing will be displayed in gallery. Similarly, if you select the All Without 
Current Drawing option, all object styles excluding the style for currently open drawing will 
be displayed in gallery.

Search Style
You can search for an object style or definition by typing its name in the Search Style edit box. The 
search results of styles or definitions will be displayed in the gallery of the STYLES BROWSER 
palette. The results displayed will also depend on the options selected in the drop-down list in 
the STYLES BROWSER palette.

Import Styles
This button is used to directly start the drawing by importing the object styles or definitions 
which are not available in the current drawing. To import an object style or definition, 

select them from the gallery and then choose the Import Styles button; a green check mark will 
be displayed adjacent to selected style or definition. This green check mark indicates that the 
selected style will be imported to the current drawing.
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Add object
This button is used to directly start the drawing without importing the object styles or 
definitions to the current drawing. To do so, select the object style from the gallery and 

choose the Add object button and start drawing in the drawing area. On choosing the desired 
style or definition, a green check mark will be displayed adjacent to selected style or definition. 
This green check mark indicates that the selected style is imported to the current drawing.

Apply style to selection
This button is used to override the object styles or definitions for the selected object from 
the drawing area. To override a style or definition, select the object from the drawing area. 

Next, select a different style or definition for that object from the gallery and choose the Apply 
style to selection button; the selected style or definition will override the existing style.

Gallery Options
These options are available at the right side of the Apply style to selection button, refer to 
Figure 2-24. By using these options, you can change the preview size, view direction, and 
background color of the styles available in the gallery.

SPACE
Space is an entity used in AutoCAD MEP to find out technical information about a specific section 
of an architectural drawing of a project. For example, if you want to make a specific section of 
a drawing as an office, then you need to assign corresponding space style to that section. The 
properties of that office such as area, airflow, height, equipment, and load are stored in the 
space style. To assign a space style to an area, first you need to create a space. The method to 
create a space is discussed next.

Creating Spaces
To create a space, choose the Space tool from the Space drop-down in the Build panel of 
the Home tab of the Architecture workspace. This tool is also available in the other 

workspaces. You can invoke this tool from any of the workspaces by entering the SPACEADD 
command at the command prompt. On invoking the Space tool, the PROPERTIES palette will 
also be displayed. By default, the Rectangle option is selected in the command prompt. Note 
that when you invoke the Space tool by entering the command at the command prompt, a 
default-sized space will be attached to the cursor automatically without selecting any option. 
You need to select Create type from the command prompt. On doing so, different options will 
be displayed. Select the Insert option;  a space of default size will be attached to the cursor. You 
need to click in the drawing area to specify the position of the space. As soon as you specify the 
position of space, you will be prompted to specify the rotation value for the space. Specify the 
rotation value; the space will be positioned at the defined point. The command prompt using 
the SPACEADD command for creating the space is given next.

Start corner or [Name/STyle/Create type/Height]: C
Set create type [Insert/Polygon/Generate] <Rectangle>: I
Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag point/
MAtch]: Enter the co-ordinates of the insertion point or click in the drawing area.
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Rotation or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag point/MAtch/Undo] 
<0>: Enter the rotation angle of the space.
Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag point/MAtch/
Undo]: Press ENTER to exit the tool or select an option.

The options available in the Command prompt are discussed next.

Name
The Name option is used to define a name for the space created by using the SPACEADD 
command. By default, the Space name is assigned to the newly created space.

STyle
The STyle option is used to change the style of the space. By default, the Standard style is 
selected. You can change the space style by using the SPACESTYLE command or by using the 
STYLES BROWSER. This command will be discussed later in this chapter.

Create type
The Create type option is used to change the type of space to be created. The space to be created 
can be a rectangle, a polygon, or it can be associative to the boundary objects. The command 
prompt after selecting the Create type option is given next.

Start corner or [Name/STyle/Create type/Height]: C
Set create type [Insert/Polygon/Generate] <Rectangle>:

According to the above command prompt, there are four options to create a space. These options 
are discussed next.

Insert:  If you select the Create type command from the command prompt, a list of options 
will be displayed. Choose the Insert option or press I and then press the ENTER key; the 
space will be created according to the target dimensions specified. Figure 2-25 shows a space 
created by using the Insert option. The Command prompt for creating a space by using 
the Insert option is given next.

Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: Specify the insertion point.
Rotation or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch/Undo] <default value>: Specify the rotation value for the space, or press ENTER 
to accept the default values.
Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch/Undo]: Press ENTER to exit the tool or select an option.
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Figure 2-25  The space created 
by using the Insert option

Polygon: By choosing this option, you can create a polygonal space by manually defining 
the segments of the polygon. You can create a polygon type space either by using the arcs 
or by using the lines. Figure 2-26 shows the polygon type space created by using the arcs 
and Figure 2-27 shows the polygon type space created by using the lines.

Figure 2-26  The polygon type space 
created by using arcs

             

Figure 2-27  The polygon type space 
created by using lines

Generate: On choosing this option, the space created

Figure 2-28  The Analyzing Potential 
Spaces dialog box

 
will be associative to the boundary objects. If you 
do not have any object with its space boundaries 
defined or with a valid space boundary, then the 
Analyzing Potential Spaces dialog box will be 
displayed, as shown in Figure 2-28. You can use 
all the visible objects to create a bounding space 
by choosing the Use all visible objects to bound 
spaces option from the dialog box. You can also 
select an object to create the bound space. To do 
so, choose the Select objects that should bound 
spaces option from the dialog box. 
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After selecting the Create type option from the command prompt, select the Insert option. The 
following options appear in the command bar.

Length
The Length option is used to change the length of the space to be created. By default, the 
target dimension of the space style is used as the length of the space. The Command prompt 
to change the length is given next.

Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: L
Length <default value>: Enter the desired value of length.

WIdth
The WIdth option is used to change the width of the space to be created. By default, the target 
dimension of space style is used as the width of the space. The Command prompt to change 
the width is given next.

Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: WI
Length <default value>: Enter the desired value of width.

Height
The Height option is used to change the height of the space to be created. By default, the target 
dimension of space style is used as the height of the space. The Command prompt to change 
the height is given next.

Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: H
Length <default value>: Enter the desired value of height.

MOve
The MOve option is used to move the space created. This option is available only if you have 
chosen Insert from the Create type options. After moving the space, you can also rotate the 
space by a specified angle. The Command prompt to move the space is given next. 

Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: MO
Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: Specify the insertion point by clicking or entering the coordinates.
Rotation or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch/Undo] <0>: Specify the rotation angle by clicking or entering the value, and press 
ENTER.

SIze
The SIze option is used to specify the size of the space to be created. This option is available only 
if you have selected Insert from the Create type option. The command prompt for specifying 
the size of the space is given next.
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Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: SI
Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: Specify the insertion point by clicking or entering the coordinates.
New size or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch/Undo] <default value>: Specify the insertion point by clicking or entering the dimensions.
Rotation or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch/Undo] <0>: Specify the rotation angle by clicking or entering the value.

Drag point
The Drag point option is used to change the orientation of the space to be created. This option 
is available only if you have selected Insert from the Create type options. The command prompt 
to change the orientation of the space is given next.

Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: D
Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: Enter D again if you want to change the orientation or press ENTER to exit.

MAtch
The MAtch option is used to match the style of the newly created space with an existing space. 
This option is available only if you have selected Insert from the Create type options. The 
Command prompt to change the orientation of the space is given next.

Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: MA

Select a space to match: Select the space created earlier to use its properties for new space.
Match [Style/Length/Width/Height] <All>: Enter any of the options available in the prompt to match 
the properties. By default, the All option is selected, so all the properties of selected space are copied in the 
new space. Now, click in the drawing area to place it.

Arc
This option is used to create an arc in a polygon type space. The Arc option is available only 
when Polygon is selected from the Create type options. The command prompt to create a 
polygon type space using an arc is discussed next.

Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: C
Set create type [Rectangle/Polygon/Generate] <Insert>:P
Start point or [Name/STyle/Create type/Height/Arc]:A
Start point or [Name/STyle/Create type/Height/Line]: Specify the first point of the arc.
Second point or [Name/STyle/Create type/Height/Line/Undo]: Specify the second point of the arc.
Next point or [Name/STyle/Create type/Height/Line/Undo]: Specify the third point to complete the arc.
Second point or [Name/STyle/CReate type/Height/Line/Close/Ortho/Undo]: Specify the next point.
Next point or [Name/STyle/CReate type/Height/Line/Close/Ortho/Undo]: Specify the next point 
or enter C to close the arc for creating the space.
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Line
This option is used to create a polygon by using the line. The Line option is available only when 
Polygon is selected from the Create type options and then Arc is chosen in the next prompt. 
The Command prompt to create a polygon type space using lines is discussed next.

Insertion point or [Name/STyle/Create type/Length/WIdth/Height/MOve/SIze/Drag 
point/MAtch]: C
Set create type [Rectangle/Polygon/Generate] <Insert>: P
Start point or [Name/STyle/Create type/Height/Arc]: A
Start point or [Name/STyle/Create type/Height/Line]: L
Start point or [Name/STyle/Create type/Height/Arc]: Specify the start point of the polygon.
Next point or [Name/STyle/Create type/Height/Arc/Undo]: Specify the end point of the first line of 
the polygon.
Next point or [Name/STyle/Create type/Height/Arc/Ortho/Undo]: Specify the end point of the second 
line of the polygon.
Next point or [Name/STyle/CReate type/Height/Arc/Close/Ortho/Undo]: Specify the next point or 
enter C to close the polygon.

Editing Spaces
You can perform various editing operations on the created spaces. For example, you can change 
the space style or divide a space. When you select a space from the drawing area, the Space 
contextual tab will be available in the Ribbon, refer to Figure 2-29. The options in this tab are 
discussed next.

Figure 2-29  The Space contextual tab

Select Similar
The Select Similar tool is used to select all those components from the drawing area 
which have the same style and layer as the selected object. The objects with the same 
style and properties but different layers will not be selected by this tool.

Object Viewer
The Object Viewer tool is used to display the selected object in a separate 3D preview 
window. When you choose this tool, the Object Viewer dialog will be displayed with 
selected object, as shown in Figure 2-30.

Various tools such as Parallel, Perspective, and Zoom Window are in the main toolbar of this 
dialog box. These tools are used to change the display of view.
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Figure 2-30  The Object Viewer dialog box

Isolate Objects Drop-down
This drop-down is available in the General panel of the Space contextual tab of the Ribbon. 
The tools in this drop-down are used to control the visibility of the objects. These tools are 
discussed next.

Isolate Objects							                 
This tool is used to hide all the deselected objects from the drawing area. 

Hide Objects							                  
This tool is used to hide the selected objects from the drawing area.
	

End Isolation
This tool is used to display all the hidden objects.

Edit in Section
This drop-down is available in the General panel of the Space contextual tab in the Ribbon. 
The tools in this drop-down are used to edit the space created. These tools are discussed next. 

Edit in Section
This tool is used to edit an object in a predefined section.

Edit in Elevation
This tool is used to edit the space at a certain elevation distance from the selected reference.
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Edit in Plan		     
This tool is used to edit the space at certain plan distance from the selected reference.

Edit Style
This drop-down is available in the General panel of the Space contextual tab in the Ribbon. The 
tools in this drop-down are used to modify the style of the space. These tools are discussed next.

Edit Style
By using the options in this dialog box, you can change different properties of the 
selected space such as length and width of the space, target area, and various offset 
values. When you choose this tool, the Space Style Properties - Standard dialog box 

will be displayed, as shown in Figure 2-31. Using the options in the dialog box, you can 
modify the style of the selected space. 

Figure 2-31  The Space Style Properties - Standard dialog box

Space Styles
When you choose this tool, the Style Manager dialog box will be displayed, as shown in 
Figure 2-32. The space styles available in the current drawing file are displayed in the left 
area of this dialog box under the Space Styles category. If you select any space style from 
this area, the options to change the space style will be displayed in the right area of the 
dialog box. These options are similar to the options displayed in the Space Style Properties 
dialog box.

Display Theme Styles
When you choose this tool, the Style Manager dialog box will be displayed, as shown 
in Figure 2-33. Various theme styles available in the drawing are displayed in the left 
area of this dialog box under the Display Theme Styles category. If you choose a 

theme style from this area, the options to change the properties of the selected theme are 
displayed in the right area. Using these options, you can change the properties of the selected 
theme such as title, text style, symbol, and so on. 



Getting Started with AutoCAD MEP		                                   2-27                                                               

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 2-32  The Style Manager dialog box

Figure 2-33  The Style Manager dialog box with theme style options

Zone Templates								                
The Zone Templates tool is used to change the properties of the selected zone template 
such as its contents, modifiers, and name. To do so, choose the Zone Templates tool; 
the Style Manager dialog box will be displayed, as shown Figure 2-34. 
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Figure 2-34  The Style Manager dialog box with Zone Templates selected

Various zone template styles available in the drawing are displayed in the left area of this dialog 
box under the Zone Templates category. When you choose a template style from the left area, 
the options to change the properties of the selected template style are displayed in the right 
area. Using these options, you can change the properties of the selected template style. 

Similarly, you can change the zone style by using the Zone Style tool available in the same 
drop-down.

Copy Style									           
This tool is used to create a copy of the style of the selected object. 

Dimension									           
This tool is used to add AEC dimension to an object. To 

Figure 2-35  The Edit Property Set 
Data dialog box

add a dimension, choose this tool; the dimension will 
be attached to the cursor. Now, you can place the dimension 
at the desired location.

Tag	     
This tool is used to add a tag to the object. To add a 
tag, choose Space > General > Tag from the Ribbon; 

you will be prompted to select an object on which you want 
to add a tag. On selecting the object, the tag will be attached 
to the cursor. Now, place the tag at the desired location. 
When you click to place the tag, the Edit Property Set Data 
dialog box will be displayed, as shown in Figure 2-35.
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Using the fields available in this dialog box, you can change the properties of the tag for the 
selected object.

Update
This drop-down is available in the Modify panel. The tools available in this drop-down are 
used to update spaces. There are two tools available in this drop-down: Selected Space and 
All Associative Spaces. The Selected Space tool is used to update the selected space. The All 
Associative Spaces tool is used to update all the spaces associated with the selected space.

Edit in Place							               
This tool is used to edit an extruded 3D space when you are in Isometric orientation. To 
do so, choose Space > Modify > Edit in Place from the Ribbon; the Edit in Place: Space 
Body Modifier contextual tab will be displayed and the selected space will be converted 

into a free form space. Now, using the vertices and control points available in the free form 
space, you can edit the shape and size of the space. When you hover the cursor over the center 
point of a selected face, a contextual menu with the editing options will be attached to the cursor, 
refer to Figure 2-36. 

Figure 2-36  The information box showing 
various editing options

Edit Surfaces							               
This tool is used to edit only the faces of the space. Choose Space > Modify > Edit 
Surfaces from the Ribbon; the selected space will be converted into a free form space. 
Now, using the midpoints of edges, you can edit the faces of the selected space. Also, a 

plus icon will be displayed at the bottom face of the space, refer to Figure 2-37. Using this plus 
icon, you can add windows and doors to the selected space.

Figure 2-37  Space with editing points
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Edit Vertices							              
This tool is used  to add a vertex to the selected edge. To do so, choose Space > Modify > 
Edit Vertices from the Ribbon; the vertex will be attached to the cursor and you will be 
prompted to click in the drawing area to add the vertex, refer to Figure 2-38. Next, click 

in the drawing area; the vertex will be added to the corresponding edge. To remove the vertex, 
press and hold the CTRL or SHIFT key and then click on the vertex to be removed.

Note
To use the Edit in Place, Edit Surfaces, and Edit Vertices tools, you need to switch to isometric 
view.

Figure 2-38  Space with its vertex attached to the cursor

Make Associative
This tool is used to make the bounding objects associative to the selected space. To do so, choose 
Space > Modify > Make Associative from the Ribbon; the objects bounding the space will 
become associative with it. Note that for making space associative with the object, the boundary 
of the object must enclose the selected space.

Create Polyline
This tool is used to create a polyline around the selected space. To create a polyline around a 
selected space, choose Space > Modify > Create Polyline from the Ribbon; a polyline will be 
created around the selected space.

Divide Space
The Divide Space tool is available in the Modify panel of the Space tab. This tool is used to 
divide the selected space by using a line. 

Interference
The tools available in this drop-down are used to add or remove an interference condition from 
a selected space. 

Remove Void
The Remove Void tool is used to remove a selected void from non-associative space. To remove 
the voids, select the Remove Void tool; you will be promted to select the void. Now select the 
void to be removed and press ENTER.
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Reset All
This option is used to revert all the changes taken place due to the grip editing of  boundaries. 
To do so, choose Space > Boundary > Reset All from the Ribbon and select the spaces whose 
boundaries are to be reset to original state.

Space/Zone Manager
The Space/Zone Manager tool is available in the Helpers panel of the Space tab. This tool is 
used to change the properties of the selected space or zone.

Show Boundaries
The Show Boundaries tool is available in the Helpers panel of the Space tab. This tool is used 
to show only the objects in the drawing area that are currently defined as boundary objects. 
This tool is available only for associated spaces.

ZONE
A zone is a group of spaces which are used for a specific function; for example, a zone created 
for a specific temperature condition. You can create a zone or zones by using the Zone tool 
available in the Space drop-down of the Build panel in the Home tab of the Ribbon. When 
you choose this tool, a box will get attached to the cursor and you will be prompted to specify 
the location where the zone tag is to be inserted. Click in the drawing area; the zone will be 
created and name of the zone will be displayed along with the box. By default, Zone is displayed 
as the name for the created zone. You can change this name by using the Name field in the 
PROPERTIES palette. You can edit a zone by using the options available in the Zone contextual 
tab. The Zone contextual tab is displayed on selecting the zone. The options available in this 
tab have already been discussed this chapter.

WORKSPACES
A workspace is a combination of menus, toolbars, Ribbon, palettes,

Figure 2-39  The Workspace 
Switching flyout

 
and control panels. It is used to represent a customized drawing 
environment based on the user requirement. In AutoCAD MEP, 
six default workspaces are available in the Workspace Switching 
flyout of the Application Status Bar, refer to Figure 2-39. 
These workspaces are HVAC, Piping, Electrical, Plumbing, 
Schematic, and Architecture.

The options in the Workspace Switching flyout are discussed next.

HVAC
The tools in the HVAC workspace are used for designing heating, 
ventilation, and air conditioning system. Therefore, on invoking 
the HVAC workspace, the tools related to the HVAC design will 
be displayed.

Piping
The tools in the Piping workspace are used for routing and creating pipe lines in the building. 
To switch to this workspace, choose the Piping option from the Workspace Switching flyout; 
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the options in the Ribbon and TOOL PALETTES will change according to the workspace. Note 
that some options for plumbing are also available in this workspace.

Electrical
The tools in the Electrical workspace are used for creating electrical circuits, panels, devices, 
equipment, and cable trays. To switch to this workspace, choose the Electrical option from the 
Workspace Switching flyout; the options in the Ribbon and TOOL PALETTES will change 
according to the workspace. 

Plumbing
Tools available in this workspace are similar to the tools in the Piping workspace. The tools in 
this workspace are used for routing and creating plumbing lines in the building. To switch to 
this workspace, choose the Plumbing option from the Workspace Switching flyout; the options 
in the Ribbon and TOOL PALETTES will change according to the workspace. Some of the 
options for piping are also available in this workspace. Plumbing is concerned with the drainage 
and other water related applications, whereas piping has a broad application area such as gas 
supply and petroleum lines.

Schematic
Schematics is the symbolic representation of an object. Using the Schematic workspace, you can 
represent MEP objects in the form of symbols. Some of the tools available in this workspace are 
schematic lines and schematic symbols.   

Architecture
The tools in the Architecture workspace are used to create architectural objects such as walls, 
doors, windows, and stairs. An architectural layout creates foundation for other domains such 
as piping, HVAC, electrical, and so on. To switch to this workspace, choose the Architecture 
option from the Workspace Switching flyout; the Ribbon and TOOL PALETTES will change 
accordingly.

You can switch between the workspaces anytime during designing by using the Workspace 
Switching flyout. Also, you can customize any of the workspaces by using the Customize tool 
available in the Workspace Switching flyout. This tool is discussed next.

Customize
The Customize tool is used to customize the user interface of AutoCAD MEP. On invoking this 
tool from the Workspace Switching flyout, the Customize User Interface dialog box will be 
displayed, as shown in Figure 2-40. The areas in this dialog box are discussed next.

Customization in All Files
The options in this area are used to select the customization file to be used for modification. 
Also, you can change the properties of the selected item from this area. On selecting an option 
from this area, the related properties are displayed in the Properties area available on the right 
of this dialog box.



Getting Started with AutoCAD MEP		                                   2-33                                                               

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Command List
The options in this area are used to customize the selected command. On selecting a command 
from this area, the Button Image area is displayed at the top right corner of this dialog box. 
You can change the icon used for the selected button by using the options available in this area.

Properties
The options in this area are used to change the specifications of the selected option.  

Figure 2-40  The Customize User Interface dialog box
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 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 In AutoCAD MEP, a level refers to a __________ .

2.	 The __________ tool is used to display the Autodesk Content Browser related to the current 
loaded project.

3.	 A zone is a division of __________ which is used for a specific function.

4.	 The __________ tool is used to add an instance of the selected object to the drawing. 

5.	 The extension for AutoCAD MEP project files is .apt. (T/F)

6.	 You can create a category while changing the current directory of project files. (T/F)

7.	 The PROJECT NAVIGATOR is used to manage the drawing files of a project. (T/F)

 Review Questions
Answer the following questions:

1.	 Schematics is the __________ representation of an object.

2.	 You can edit a 3D extruded space by using the __________ tool.

3.	 The Synchronize Projects tool is used to synchronize the current project with the previous 
project standards. (T/F) 

4.	 You can create a space by using the SPACEADD command. (T/F) 

5.	 The Customize tool is used to customize the user interface of AutoCAD MEP. (T/F)

Answers to Self-Evaluation Test  
1. floor, 2. Content Browser, 3. space, 4. Add Selected, 5. F, 6. T, 7. T


